

http://www.wiley.com/buy/0470523972

Taking Advantage
of Paths

serves this purpose and does it quite well. However, even in raster IN THIS CHAPTER
editing, in some circumstances having the ability to use vector tools
is a definite advantage. This is where GIMP’s paths come in. They provide

G IMP’s primary purpose is to be an awesome raster graphics editor. It

Understanding what paths are

you with the vector advantages you need without making GIMP a full-on good for
vector illustration program. Using paths to good advantage
Paths are curves, specifically Bézier curves like the ones commonly found in Removing paths from your file

vector drawing programs such as Inkscape or Adobe Illustrator. They're a
very powerful way to define reusable forms that you can employ for selec-
tion, creating solid shapes, or making line drawings. You can also use them
as a control structure for text, defining a form for the text to flow along.

This chapter builds on the brief section in Chapter 4 on the Paths tool. You
will not only discover how the vector nature of paths can be an advantage to
you while editing, but also how to get the most out of them in the process.

By the time you're done, you'll be creating, editing, and deleting paths with

the best of them.

The Advantages of Paths: Get
Some Vector in Your Raster

So where exactly is it useful to have vector drawing tools in a raster graphics
package like GIMP? Well, vectors give you two primary benefits:

e Resolution-independence — Vector graphics are not bound to any
particular image size or resolution. This means that you can take a
symbol drawn with vectors and use it in an image sized for either
a web site or a billboard and there’s no jagged stair-stepping at the
edges or other degradation of quality.
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FIGURE 5-1

e Easy modification — Because vectors are basically mathematical curves with only a few
control points, they’re much easier to change and edit. This makes them well-suited for
building selections around objects with irregular edging. Paths can often be much more
forgiving to use than the Free Select (or Lasso, for you Photoshoppers) tool.

These advantages make vector graphics ideal for use with logos and text, because they tend to
get reused frequently in a variety of output media. It’s best to keep this flexibility for as long as
possible. In a commercial design environment, it's not uncommon for a client to request for text
to be larger or the logo to be enlarged and moved or rotated. If you can do these operations with
a vector, your output won't suffer from quality loss from resizing or transforming.

GIMP provides vector drawing capabilities with the Paths tool (B). In GIMP, a path is defined by
a specific kind of curve called a Bézier curve. The most prominent features of Bézier curves are its
control points, called anchors. These anchors lie along the surface of the curve and each one has
a pair of handles associated with it. The handles control how smoothly the curve approaches and
leaves each anchor. Handles can be either in alignment with one another, ensuring a smooth
transition of the curve through the anchor, or they can be “broken” to move independently,
making the curve have a sharp point at the anchor. You can also control whether a path forms a
closed solid shape or is simply a line, known as an open path. With these controls, you can easily
use a path to create a smoothly curved line or a line with a variety of sharp points all over it.
You can even use it to create geometric shapes and straight lines. Figure 5-1 shows a couple of
example paths with their anchors and handles visible so you can see how they work.

Paths can be used to create a wide variety of lines and shapes.
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Aligned handles

Free/broken handles

Mixed handles

Creating Paths

When it comes to creating and editing paths, nearly all of the functionality resides in the Paths
tool. You can activate this tool by clicking its icon in the Toolbox or by pressing its keyboard
shortcut, B. If you've used other image editing programs, you may recognize this as the Pen tool.
For familiarity, the icon in the Toolbox depicts a fountain pen manipulating a Bézier curve.
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Drawing with the Path tool

Drawing with the Path tool is remarkably straightforward. With the tool active, click in the
image window and a new anchor appears where you've clicked. Click again and you'll add a new
anchor. If you click and drag your mouse, GIMP immediately gives you control of the handles
for the anchor you add. When you control the handles in this way, their default behavior is to be
aligned to one another. However, if you would like to break them and freely control the far han-
dle, press and release Shift while dragging your mouse. From this point, if you decide that you
want to have the handles aligned, press and hold Shift while you're dragging your mouse. When
you release Shift, the handles revert to their free behavior. Figure 5-2 illustrates how this works.

FIGURE 5-2

Drawing a new path with the Path tool

Paths tool

Left-click creates a new anchor

Left-click and drag While click-dragging, While click-dragging,
creates an anchor press and release Shift press and hold Shift
with aligned handles to break handles to align handles

Tip

The semi-toggle nature of the Shift button when drawing paths may seem a bit strange at first, but it’s
surprisingly helpful. It’s a great way to control both handles without releasing the mouse button. An
example workflow would be to place your first anchor and then click and drag from the location of
your next anchor. Use this moment to control the angle of the far handle. Once you have it set, press
and release Shift to control the placement of the handle near your mouse. If you have to tweak the far
handle, hold Shift momentarily to fix it and then release to go back to adjusting the near handle. This is a
particularly helpful trick for tablet users. W

If you want your path to form a closed shape, move your mouse cursor over the first anchor

in the path and press and hold Ctrl. When you do this, your mouse cursor should change to
include a small chain-link symbol in the upper right. Confirm closing the path by left-clicking. If
you need to add more anchors anywhere along your path, Ctrl4-click any segment between two
anchors in the path. Anchors can be deleted by Shift4-Ctrl-clicking them.

You can adjust any individual anchor by clicking it and dragging it to a new location. If you
need to move multiple anchors simultaneously, you first have to select each one. Do this by
Shift-clicking the anchors you want to move. Selected anchors appear as outlined circles and
unselected anchors appear as circles filled with a solid purple color. With your anchors selected,
move them by clicking any one of them and dragging the group to its new location.
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GIMP gives you the ability to construct your path out of a set of individual components. Each
component is an individual set of anchors forming their own curve. To create a new component,
Shift+click anywhere in the image window and a new anchor that isn’t linked to your existing
component appears. Subsequent clicks draw a curve from this new anchor. With multiple com-
ponents floating around, things can get to be a bit of a visual mess. Fortunately, GIMP allows
you to manage this. Alt+clicking any component and dragging your mouse around the screen
moves that component. If you Alt4-click anywhere else in the image window, you'll move all of
the components in the path. By using multiple components to build a path, you have quite a bit
more control when using paths to create selections. In fact, you'll see later in this chapter how
overlapping components can produce holes in your selections made with paths.

You may notice that some of your anchors don’t appear to have handles. This happens when you
create your path by just clicking new anchor points and not dragging your mouse to control
the handles immediately. To reveal and edit handles on an anchor, Ctrl+4-click it and drag your
mouse away from that anchor’s center. When you do so, one of the handles will follow your
mouse. You can control the opposite handle by pressing and holding Shift while you're still
dragging out the near handle. Release Shift to relinquish control of that opposite handle. Alterna-
tively, you can release your mouse button, go back to the anchor, and Ctrl+click it to draw that
other handle out. Figure 5-3 illustrates how this process works.

FIGURE 5-3

Editing existing anchors and handles.
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an anchor’s handle editing to reveal anchor to reveal the
the opposite handle opposite handle separately

Tip

For a quick edit, you can actually click and drag any segment between two anchors. When you do this,
GIMP modifies the handles on each anchor to generate the curve shape you want. If you hold Shift while
doing this, those handles will be aligned on their anchors. Note that where you click the segment is
important. If you click halfway between the two anchors, you’ll have equal control over both near handles.
However, if you click nearer to one anchor than the other, your control of each handle is proportionate to
the distance you are from it. So if you click closer to one anchor, you'll have immediate control over its
handle, but much less control over the other anchor’s handle. B

Tip

There will be occasions when you want to draw a path with only linear segments. To avoid accidentally pul-
ling out handles from your anchors in these cases, there’s a check box called Polygonal in the Tool Options
for the Paths tool. If you click this check box and enable it, as shown in Figure 5-4, new anchors that you

create will not grow handles if you click and drag on them. Doing so will only move that anchor around. B
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FIGURE 5-4

You can enable the Polygonal option in the Paths tool’s options in the Toolbox.

Table 5-1 has a quick reference for the various mouse and keyboard shortcut combinations that

the Path tool uses.

TABLE 5-1

Mouse/Keyboard Shortcut Reference for the Path Tool

Shortcut

Behavior

Click empty space
Click-+drag empty space
Click+drag anchor
Click+drag handle
Click+drag path segment

Shift+click empty space
Shift+click anchor
Shift+click+drag handle
Shift+click drag path
Ctrl+click+drag anchor
Ctrl+click first anchor

Ctrl+click path segment
Alt+click+drag empty space
Alt+click+drag path component
Shift+Ctrl+click anchor or handle

Add anchor

Add anchorand adjust handle (press and release Shift to break handles)
Move anchor (or anchors if multiple anchors are selected)

Move handle independently

Adjust path curvature by editing two handles simultaneously (click
segment center for equal control of both handles)

Add unconnected anchor

Select anchor

Move handles aligned

Same as click+drag path segment, but with aligned handles
Reveal handle and move it independently

Close path component

Add anchor in the path segment where you click

Move complete path

Move path component (connected anchors)

Delete anchor or handle
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Tip

This table has a pretty daunting list of mouse/keyboard combinations that may be tough to remember.
Your life can be simplified a bit by using the radio buttons in the tool options for the Paths tool, shown
in Figure 5-4. The combinations in Table 5-1 all work when you have the Paths tool in Design mode. How-
ever, if you know that you don’t want to create new anchors and you just want to adjust an existing path,
you can switch to Edit mode in the tool options and your controls will be limited to editing paths. If you
just want to move path components without editing them or creating new anchors, using the Paths tool’s
Move mode will simplify things for you so you don’t have to remember as many keyboard shortcuts. Of
course, once you have the shortcuts down, you can edit paths at an incredible pace. A good trick is to pay
attention to the status bar at the bottom of the image window. It gives you hints about helpful keyboard
shortcuts to use while editing. B

Creating a Path from a Selection

Although drawing your own custom path gives you the ultimate control over how it’s shaped,
it’s often helpful if you're given a head start. Perhaps you're given a symbol or a logo to work
with, but it’s a very small raster image and you've been asked to enlarge it. If you try to sim-

ply scale it up, chances are good that it will be blurry and possibly pixelated. However, if you
could get it in paths, resizing might be simpler. Fortunately, because most logos and symbols

are solid colors, it’s pretty easy to do this quickly. Note that this example uses a few concepts
discussed later in this chapter, including the Paths dockable dialog and converting a path to a
selection. If you want to find out more about these things, flip forward a few pages to preview

them.

1.
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With the Fuzzy Select (U) or Select by Color (Shift+0) tools, select one of
the solid colors in the logo. This gives you a base selection to work with. You may
have to go in and clean up the selection, but it really depends on the image you're
starting with.

Change the path to a selection (Select > To Path). BAM! Your selection is now a path
and free of the constraints of raster images. This step is where all of the fun of this tech-
nique lies.

Perform steps 1 and 2 on other colors in the logo. When finished, you should have
a separate path that defines each color in the logo. You can see each of these paths in the
Paths dockable dialog, which is covered in more detail later in this chapter.

Scale the image up to the desired size (Image > Scale Image). In doing so, you also
scale up the paths. Because they’re vector, though, the lines remain crisp and the curves
remain smooth.

Add a new layer (Add > New Layer or Shift+Ctrl4+-N). This is where you will be
putting your reconstructed logo.
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6. For each path in the Paths dialog, convert the path to a selection (Select > From
Path or Shift+V) and Bucket Fill (Shift+B) that selection with the proper color.
You may need to use the color picker (O) to select the matching color from the old logo in
the lower layer before completing the Bucket Fill. And remember, to fill the whole selec-
tion with the Bucket Fill too, use Shift+click in the selected area.

7. You've done a quick logo enlargement without losing much, if any, quality.
Figure 5-5 has an example of this process in action.

FIGURE 5-5

Using a selection to create a path so you can cleanly enlarge a simple logo

1
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FIGURE 5-6

The default settings for the Select to Path feature work well in most instances. However, occa-
sionally you may find that GIMP creates too many or too few anchors to match your selection
exactly. You could also want to create a path that’s a simplified, smoother approximation of your
selection. For any of these scenarios, you can use the Advanced options for the Select to Path
feature. Because it’'s not a frequently used set of options, you won’t find the advanced options in
GIMP’s main menu. Instead, the way to access these options is from the Paths dockable dialog.
At the bottom of the dialog is a red Select to Path button. If you Shift+click this button, you get
a dialog like the one in Figure 5-6.

Advanced options for creating a path from a selection
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This is an impressive and somewhat overwhelming list of options and they’re in “program-
merese.” The reason for this is that these sliders give you low-level control over how the path
is generated and they directly influence how GIMP converts a raster selection into a vector
curve. The online GIMP manual says that these options “probably [are] only useful to GIMP
developers.” However, if you want real control over how the path is created and you don’t want
to spend a lot of time adding or deleting anchors to adjust your path, knowing how even a
handful of these options affect the final output can be a great help.

Before getting into the details of each setting, though, it's helpful to understand the process that
GIMP uses to convert a selection to a path. Assume for a moment that you've made a single con-
tiguous selection, say with the Rectangle or Ellipse Select tool. GIMP starts by choosing a start
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position on the selection and from there it generates a series of points along the edge of your
selection. With these points as an initial state, GIMP attempts to filter out points that don’t add
any detail, such as points along a straight line. It also tries to determine whether a point more
clearly defines the shape of the selection as a corner anchor or an anchor with aligned handles.
GIMP also tests its decisions to see if the created path accurately fits the original selection. If not,
it generates an alternative set of points and checks if those are a better fit. GIMP will iteratively
continue this refinement process, called reparameterization, until it reaches a threshold whereby
continuing doesn’t yield a large enough change. At that time, GIMP treats the remaining points
as anchors and presents you with a path from your selection. This appears to be a lot of steps,
but it typically happens almost instantaneously. Now, on to the individual settings:

Align Threshold — The ToolTip for this option states “If two endpoints are closer than
this, they are made to be equal” and the values range from 0.2 to 2.0. Basically this has to
do with the start and end of the path created from your selection. At low values, there’s
a greater chance that you'll have two anchors near each other at that point. At high val-
ues, you may not even have any anchors there and the shape is defined by surrounding
anchors.

Corner Always Threshold — Measured in degrees, this defines whether a point creates a
corner. Looking at the points before and after the point it’s evaluating, if those other points
form an angle that is smaller than this value, GIMP marks this point as a corner. This set-
ting has an influence regardless of whatever is set for Corner Surround. If you set this to its
maximum value, all points are considered corners.

Corner Surround — When determining whether a point is a corner, you can control
how many points before or after it GIMP uses to make this determination. On complex
selections, lower values should give you more accurate results, although you'll have more
anchors at detailed parts of the selection.

Corner Threshold — Similar to Corner Always Threshold, but this setting is dependent
on the value you set for Corner Surround. Increasing this threshold to 180 degrees not
only makes all points into corners, but also dramatically increases the overall number of
anchors used to create your path.

Error Threshold — Consider this value to be an accuracy setting for the path. The lower
the number you use here, the more accurately your path matches your selection. Higher
numbers are less accurate, but they’re a handy way of quickly simplifying a complex selec-
tion to a nice, clean shape.

Filter Alternative Surround — Increasing the value for this option increases the number
of anchors you have at curved portions of your selections.

Filter Epsilon — This option controls which points GIMP uses when filtering the points
it creates. Basically, GIMP takes the vectors made by Filter Surround and Filter Secondary
Surround and evaluates their angles. If the angle is less than this value, the alternative
points should be a better fit and GIMP uses the angle from Filter Alternative Surround.
Otherwise, it stays with Filter Surround. Lower values should yield you more accurate
results.

Filter Iteration Count — This value determines how many times GIMP will run a
smooth operation once it determines where the anchors are. Increasing this value reduces
accuracy, but it can help smooth out excessively rough selections.
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o Filter Percent — When determining whether to create a new point, GIMP uses this value
with the last point it created. Very high and very low values give you a lot of anchors. Val-
ues in the middle range give a smaller, more acceptable number of points.

o Filter Secondary Surround — This is the number of adjacent points that GIMP will
use to determine whether a segment is a straight line. Higher values tend to spread your
anchors out a bit more.

o Filter Surround — Increasing this value reduces accuracy, but it also helps reduce the
roughness in jagged selections.

o Keep Knees — Knees are kind of like “helper points” that GIMP uses to determine the
shape of the path created from the selection. Normally these knees get removed after the
path is calculated. However, if you'd like to keep them as control anchors, enable this
check box.

o Line Reversion Threshold — This value controls whether a segment is considered a line
or a curve. Higher values increase the likelihood that a segment will be considered a line
rather than a curve.

e Line Threshold — Increasing this value reduces the accuracy of your path and increases
the likelihood that a segment will be considered a line rather than a curve.

e Reparametrize Improvement — Increasing this value sacrifices some accuracy for
greater speed when creating the path. If you set this value to 0.0, GIMP may take quite a
while to generate your path for you.

o Reparametrize Threshold — Beyond a certain point, reparameterization stops being
useful. This value is where you adjust that threshold. Increasing it from its default value
should reduce the number of anchors in your curve, but the curve may fit less accurately.

e Subdivide Search — GIMP creates paths from selections through an iterative process. So
it may find a segment that doesn’t match the selection. If that segment is off the selection by
larger than the percentage you set here, GIMP tries to subdivide the segment somewhere
else to get a better result.

e Subdivide Surround — If GIMP does subdivide a segment to try to get a better result, it
uses this number of adjacent points on the path to decide whether or not the new subdi-
vide point is an improvement.

e Subdivide Threshold — This value, measured in pixels, is how far a segment can be
away from a straight line and still be considered an improved subdivide over the last point.

e Tangent Surround — To accurately determine how a segment should curve, it's impor-
tant for GIMP to calculate the tangent of points along that path. This value determines
how many points GIMP uses to help calculate that value. Higher values should yield more
accurate results, but with slightly more anchors in the final path.

Managing Paths

In the previous example, notice that GIMP is able to handle multiple sets of paths. When you
use the Paths tool, unless you tell GIMP otherwise, all of those curves you draw, called compo-
nents, are considered part of a single path. That path can be managed as a single complete unit
from the Paths dockable dialog, shown in Figure 5-7.
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FIGURE 5-7

The Paths dockable dialog allows you to manage all of the paths in your current project.

The Paths Dialog

By default, the Paths dialog is available in the dock window as the third tab in the upper
dock. If you don’t see it there, you can always bring it up by clicking Windows » Dockable
Dialogs » Paths in an image window. As Figure 5-7 shows, the Paths dialog is a comprehensive
list of each of the paths you have in your image. Each path entry in this list has four controllable
bits of information associated with it:

e Visibility — This eye icon is a button that controls the visibility of the path. By default,
GIMP keeps this functionality disabled. To make a path visible for editing, just click this
first icon.

e Chaining — Chaining is a concept that works on layers, channels, and paths, linking
them together and making them transform locked. This means that if you've clicked this
second space and enabled the chain icon on two paths and a layer, then when you move
the layer, the paths move with it. If you've used a path to create a selection on a layer, and
then want to move the layer, it’s a good idea to enable this feature, chaining the path and
layer together.

e Preview — This shows a small thumbnail of your path. Often it’s easier to remember the
shape of the path you created rather than its name or anything else. Double-clicking this
preview image automatically enables the Paths tool and reveals the anchors for that path,
regardless of whether the path is visible or what tool you have when double-clicking.

e Name — Each path has a unique name associated with it. For better organization (and the
sake of your own sanity while working), it’s a very good idea to give your paths names that
make sense for your image. It’s not helpful if you look at the Paths dialog and see “Path,”
“New Path,” “New Path #1,” and “New Path #2.” So whenever you create a new path, make
it a point to give it a good name. You can always change that name by double-clicking it in
this dialog.
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FIGURE 5-8

Above the list of paths is a label that says Lock, followed by a button. Locks are a new
feature in the latest version of GIMP and they can be found in the Paths dialog as well
as dialogs for Channels and Layers. After the Lock label is one or more buttons. In the
case of the Paths dialog, there is only one button. Click this button and the active path
becomes locked, or uneditable. Click it again and you unlock that path. This is useful if
you have a path set and you want to see it, but don’t want to accidentally modify it with
any stray clicks.

New Path — Clicking this button creates a new path. When you click this, GIMP pops
up a dialog like the one in Figure 5-8 that allows you to give your new path a name. Give
your path a logical name that makes sense.

The naming dialog that pops up when you create a new path

120

e Raise/Lower Path — These buttons allow you to re-order the paths in the list. Clicking

the raise button takes the selected path and moves it up in the list. Clicking the lower but-
ton moves it down. If you Shift+click either of these buttons, it raises the path to the top of
the list or lowers it to the bottom. Of course, you can also re-order your paths by clicking
and dragging a path directly to its new location in the list.

Duplicate Path — Clicking this button makes a duplicate of the currently selected path.
Do note that when you do this, GIMP appends a number to the end of the path’s name.
So if you want to give this duplicated path a custom name, double-click that name and
change it. Alternatively, you can right-click any path and choose Copy Path from the menu
that pops up. Then to add duplicates of that path, right-click the Paths dialog and select
Paste Path.

Path to Selection — This button is a controller that allows you to use the closed com-
ponents of the current path to make a selection. If you just click this button, your current
selection is completely replaced with this new one. If, however, you would like to use your
current selection along with a selection created by your path, you have a few more options
that are quickly accessible from this button.

e Add (Shift+click) — Choosing this option increases your overall selected area by
adding your path selection to what you already have selected.

e Subtract (Ctrl4click) — This option takes your current selection and deselects por-
tions that overlap with closed components of your path.

e Intersect (Shift+Ctrl+click) — On some occasions you want to select only the areas
that are covered by both your current selection and the closed components of your path.
This option does just that.
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Tip
Each of these selection functions is also available by right-clicking in the Paths dialog. B
o Selection to Path — Click this button to convert your current selection into a path.

Shift+click this button to show the advanced options for doing this conversion. Details
on these advanced options are covered earlier in this chapter.

e Paint Along the Path — One of the cool features about paths is that they allow you to
use any brush in GIMP and paint a line that goes along that path, sometimes referred to
as stroking the path. This is a great way to create outlines, edges, and even some cool neon
effects. There are a lot of controls that you can have with this and they’re discussed in the
next section of this chapter. If you've already painted along a path, Shift+clicking this but-
ton reuses those settings.

e Delete Path — As advertised, clicking this button deletes the selected path.

Occasionally you may find that you need to consolidate your paths. Perhaps you've created two
paths that you would like to work together to create a single selection. Well, rather than convert
one to a selection and then add or subtract the other from that selection, you can merge the
paths into a single one. To do this, make the paths you want to merge visible by clicking the
visibility eye for each. Then right-click in the Paths dialog and choose Merge Visible Paths. Doing
this consolidates all components from the visible paths into a single path in the Paths dialog. You
can still move the components individually by Alt+clicking and dragging any of them.

Warning

Be careful when you’re merging paths. Currently, there’s no quick way to separate components in a path.
You can always use Undo (Ctrl+Z) if you immediately realize that you didn’t mean to merge paths. How-
ever, if you don’t realize this until later or if you just decide later on that you’d like the path components
to be separate, things are going to be a bit troublesome. The way to separate components into individual
paths is by duplicating the path and manually Shift+Ctrl+clicking each anchor in the component you want
to remove from the new path. And then you need to go back to the original path and remove the anchors
from the other component in that path. Alternatively, you can export your paths to a vector graphics pro-
gram like Inkscape and separate your paths there. Either way, this process can be a bit of a bother, so keep
that in mind when you’re merging paths. B

Importing and Exporting Paths

GIMP also gives you the ability to import vector curves from other programs using the SVG file
format. SVG is an abbreviation for Scalable Vector Graphics and it’s an open vector image format
used in a variety of programs. As an open format, SVG is easily supported in proprietary com-
mercial software like Adobe Illustrator, as well as most Free Software programs like Inkscape,
Scribus, and OpenOffice.org. In fact, even Mozilla Firefox can display SVG images!

Importing Paths

GIMP’s paths were actually redesigned in GIMP 1.3.21 specifically with SVG support in mind, so
importing is painless. To import SVG paths into GIMP, right-click in the Paths dockable dialog
and choose Import Path. As Figure 5-9 shows, the File Chooser is pretty much the same one you
see when opening a new file, with the exception of two check boxes at the bottom of the dialog.
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FIGURE 5-9

The File Chooser dialog for importing paths into GIMP

Tip

The two additional options you have are as follows:

e Merge imported paths — Enable this option to import all of the curves in the selected

SVG file to a single path in the list. If you leave this option disabled, each individual curve
object in the SVG file will get its own path element in the list.

Scale imported paths to fit image — Although SVG is a vector format, SVG files have a
size and resolution associated with them so artists can relate them to real-world units. By
default, GIMP uses these values to calculate the size of the paths when they’re imported.
If you enable this option, GIMP scales the paths so they fit the image size. This means that
SVG images that are smaller than your image canvas will be scaled up while larger images
will be scaled down. Be aware, though, that GIMP does not maintain the proportions of the
SVG curves if you enable this option. It will squash or stretch the curves to fit the avail-
able size, regardless of the original proportions. If you want to maintain proportions, it’s
best to import the SVG curves at their original size and then scale the paths once they're
in GIMP.

To scale a path, choose the Transform tool and click the Path button in the Tool Options panel. This way
you can arbitrarily rescale your path to whatever size you need. B

Note

The SVG file format actually supports much more than curves. You can create vector text and shapes like
rectangles, ellipses, and stars. Unfortunately, GIMP does not support these vector forms directly. To import
these into GIMP as paths, you first need to convert them to curves in the vector drawing program you’re
using. Once you do that, however, GIMP can import them just fine. B
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Exporting Paths

Just as you can import SVG curves as GIMP paths, you can also export paths as curves in an
SVG file. This is a great way to have interoperability between GIMP and your vector drawing
tools and even 3D software like Blender, which support SVG curves. To export paths from
GIMP, right-click in the Paths dockable dialog and choose Export Path. Doing this pops up a
Save dialog like the one shown in Figure 5-10.

The Save dialog that GIMP pops up for exporting paths

This dialog looks like the standard Save dialog with the exception of an additional drop-down
box at the bottom. From this drop-down, you have two options:

e Export the active path — Choosing this option exports on the path that you have
selected in the Paths dialog. All components of this path are included as a single object in
the SVG file.

e Export all paths from this image — This option takes all of the paths in the image and
includes them in the exported SVG file. Each path is treated as its own individual object, so
you don’t have a mess of overlapping curves when you open the file in your vector draw-
ing tool.

Using Paths

Once you have one or more paths created, you can do a whole slew of things with them.
Earlier in this chapter, there’s the example of how you can use paths to cleanly enlarge a logo.
Of course, that’s just one application. Paths are best suited for creating shapes, drawing lines,
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FIGURE 5-11

making complex selections, and deforming other parts of the image. Paths are where this starts,
but when it comes to using them in these situations, there can be overlap with some of GIMP’s
other tools, particularly the Paintbrush and Bucket Fill tools.

Painting along a Path

Have you ever had trouble drawing a smoothly curving line or needed to draw a clean line with
a very specific curve? This is where paths have a distinct advantage over your typical frechand
drawing and painting tools. You can take your time and meticulously lay out the shape of a
line first. When it’s all properly laid out, you create that line in a single operation. This is done
with GIMP’s Stroke Path function (Edit > Stroke Path). You can also more quickly access this
feature from the Paths tool’s options in the Toolbox as well as at the bottom of the Paths dia-
log. Regardless of which method you choose to use, GIMP pops up a dialog box like the one in
Figure 5-11.

GIMP’s Stroke Path dialog. On the left is the standard dialog and on the right is the same dialog
with the Line Style options expanded.
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For as simple as the Stroke Path dialog appears, it’s packed with a remarkable amount of versatil-
ity. Ultimately, though, you have two main options: stroking a line with some procedural preset
or stroking with a paint tool.



Chapter 5: Taking Advantage of Paths

Stroke Line

GIMP’s default behavior is to use the Stroke Line option. This uses a set of procedural options to
generate your desired line. At its simplest, you have two settings for painting along the path this
way:

e Line Width — Allows you to control the width, or thickness, of the line you're creating
in any of the units that GIMP supports. A thing to remember is that this is the total width,
centered along the path. So if you're using a line width of 10 pixels, your stroke will be out
5 pixels on either side of the path.

e Solid/Pattern — Because you can only choose to paint with either a solid color or a pat-
tern, this counts as a single setting. If you choose Solid, your line will be drawn with the
current foreground color. If you choose Pattern, GIMP uses the active pattern to fill the
width of your line. The cool thing here is that the Stroke Path dialog is non-blocking, so you
can leave it open and still change the foreground color or active pattern to whatever you’d
like before you click the Stroke button.

The real power of using this procedural Stroke Line method is the variety of options you have
access to when you expand the Line Style options. Here you can really control the nature of
the line that gets drawn. This is great for technical drawings and illustrations where you need
specific dash patterns or you need greater control over how the line looks at its tips or at anchors
along the path that creates that line. Each of these options can have a dramatic effect on how
your line looks, regardless of whether you're using a solid color or a pattern:

e Cap Style — If you're using an open, rather than closed, path, these options control how
the line you draw terminates when it gets to the end of the path.

e Butt — When the line reaches the end of the path, it stops drawing right there,
squared off.

e Round — Occasionally you may want your lines to end more organically rather than
ending with a harsh, squared-off edge. Choosing this option terminates your line with a
semi-circle that has a diameter equal to your line width.

e Square — This is kind of a hybrid between the preceding two options. You get a
squared-off end, but it’s extended from the tip of the path by half of the line width that
you set.

e Join Style — These options control how GIMP draws your line at corners. This specif-
ically applies to anchors on your path and is most visible on linear anchors without any
handles on them.

e Miter — This is the default behavior, simply drawing a hard-edged corner at sharp,
linear anchors.

e Round — Choose this option to soften corners a bit. It draws a radius at corner
anchors, rounding them and making them less harsh.
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e Bevel — This choice is used more in technical drawings when you want to keep hard
edges, but you want something a bit smoother than the straight miter look. The size of
the bevel is determined by keeping the same line width as much a possible, rather than
the additional thickness that occurs on a corner with standard miter joins.

e Miter Limit — Even if you choose the Miter join style, you can actually still use a bevel
join style under certain circumstances where the corner is extremely sharp. If you reduce
this value to 0.0, GIMP always bevels the corners. If you set it to 100.0, GIMP never bevels,
regardless of how sharp the corner angle is.

e Dash Pattern — One of the really cool things you can do with GIMP’s stroke is draw
dashed lines. This control allows you to see the dash pattern you're using. You can also use
it to create your own custom pattern. Just click the line to toggle a portion of it as empty or
full. GIMP will then use this as its pattern when painting along your path.

e Dash Preset — In case you don’t want to spend time creating your own custom dash
pattern, GIMP comes with about 10 preset patterns ranging from a solid line to alternating
dots and dashes. Click this drop-down to select the pattern you want to use and it will be
loaded into the dash pattern setting. Then you can either choose to use this pattern or use
it as a starting point to edit your own.

e Antialiasing — Aliasing is an effect that is unique to digital images, readily recognizable
as that stair-stepped effect you see along hard edges in an image. Antialiasing is a means
of subtly blurring those edges to reduce that stair-stepping, thereby making it look more
natural. Enable this option to keep the edges of your line from being jagged and aliased.
In most circumstances you'll want to keep this enabled because lines typically look better
with antialiasing. However, on very thin lines, sometimes antialiasing hurts more than it
helps. In these circumstances, click this check box to disable it.

Figure 5-12 shows some examples of the kinds of lines you can draw with just the Stroke line
options in this dialog.

FIGURE 5-12

Some lines that can be drawn with the procedural options under Stroke Line in the Stroke Path
dialog

Stroke with a Paint Tool

The Stroke Line options give you a lot of control with procedural options. However, you can
have nearly limitless versatility if you stroke your path using one of the paint tools. Looking
back on Figure 5-11, the Stroke with a Paint Tool options seem pretty basic and innocuous;
just a drop-down menu and a check box. This is deceptively simple because when you choose
to paint along your path this way, your options are any of the options available to you in any of
the available paint tools. Your versatility here is almost limitless.
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The really unique thing here is that not only can you stroke the path using standard drawing
tools like the Pencil, Paintbrush, and Ink, but you can also use some of the more specialized
painting tools like Clone, Heal, and Smudge. This gives you a ton of additional flexibility and
options when painting along a path. If you need to, review the options for paint tools in Chapter
4 to see all of your available options. Figure 5-13 shows some examples of what can be done
with a couple brushes and a little bit of creativity.

FIGURE 5-13

Using the various options in GIMP’s paint tools to get highly customized strokes along a path

Warning

Currently, there’s a bug in GIMP when you try to use Stroke with a Paint Tool using a tool that requires you
to set a source, such as Clone, Heal, and Perspective Clone. If you try to use this painting tool with Stroke
Path, you’ll get an error dialog that says ““Set a source image first” regardless of whether or not you've
actually already set a source with that tool. This bug was confirmed in December of 2008. Hopefully it
will be fixed soon. In the meantime, there is a workaround you can use. Create a new layer and stroke
your path there with a regular paint tool. Then use Layer > Transparency > Alpha to Selection to turn your
stroke into a selection. Then hide your new layer and go back to the original layer. From here you can
use the Clone tool in the selection defined by your stroke. It's a few steps for a workaround, but at least
it works. W

It's worth it to take a moment here and look at the Emulate brush dynamics check box at the
bottom of this dialog. When you’re using the paint tools by themselves, brush dynamics are
most useful if you have a drawing tablet because when they’re enabled, they nicely emulate the
effects that occur when drawing with “real” media in meatspace. However, you can really take
advantage of them when using the Stroke Path feature. This is a great way to use your precisely
created paths to generate lines that look closer to hand-drawn. If you want tapered strokes, this
is the way to do it. To take the most advantage of this, though, you need to understand how
the stroke function relates your path to the brush dynamics values. For the painting tools that
support them, five brush dynamics settings are available:

e Pressure — When used with a tablet, pressure is controlled by how hard you press the
pen to the tablet surface. When related to paths, pressure relates to where the path starts
and stops. GIMP assumes that at the beginning and end of a stroke is where you would
have the least pressure, and the most pressure is at the middle of the stroke. So if you have
pressure associated with brush size, then as the stroke moves along your path, it will be
small at the start, increase in size, and then get smaller at the end.

e Velocity — On a tablet or a mouse, velocity relates to the distance the cursor travels in
a period of time. The faster you move your mouse or tablet pen, the higher the velocity.
When related to paths, GIMP assumes that the lowest velocity is at the beginning of the

127



Part II: Getting Started

stroke and increases as you get to the end. So if you relate this to opacity, then at the begin-
ning of the path, your stroke would be solid at the start of the path and become more and
more transparent as it nears the end of the path.

e Direction — This is a new setting that was added for GIMP 2.8. When using a tablet, this
setting relates to the direction that you draw a line. As you change the direction of a line,
you see a change in whatever you bind this setting to. When it comes to painting along
a path, the change in direction is most apparent as you cross through anchors, especially
anchors with broken handles.

o Tilt — The tilt feature relates to the angle of the drawing pen used on a tablet. The tilt
of the pen rotates the brush that you're drawing with. Currently, a path doesn’t have any
tilt influence associated with it, so this setting isn’t particularly useful when painting along
the path.

e Random — Just as with a tablet, the Random setting independently adjusts its value over
time, so it results in a highly variable stroke. You can use this like Jitter, to get uneven
strokes, or you could associate Random with color and the color of your stroke will
randomly bounce between your foreground and background colors as it moves along
your path.

The really interesting thing is that just like you can combine brush dynamics when painting, you
can also combine them when stroking a path. This can give you a high variety of natural-looking
linework. Figure 5-14 shows the results of binding pressure, velocity, direction, tilt, and random
brush dynamics to the size of a brush stroked along a path, as well as an example combining
them.

Using brush dynamics when stroking a path

Direction

Tip

In GIMP,

Velocity Direction Tilt Random

Combined

you can stroke a selection directly by choosing Edit > Stroke Selection from the image window

menu. When you do this, you get a dialog with all of the exact same options available to you when stroking
a path. This means you can immediately stroke a selection without first converting it into a path, which is
useful if you don’t want to clutter up your Paths dialog with paths that you’re never going to reuse. B
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Practical Example: Faking an Ink Drawing

All of these settings are interesting, but seeing them in action can really get the ideas and
possibilities flowing through your brain. One of the interesting things you can do with paths
and painting along them is quickly take a photograph of just about anything and make it look
like an ink drawing. Have a look at Figure 5-15. Let’s say you want to take this photo and
make it look like it was drawn and inked with a brush. This takes fewer steps than you might

think.

FIGURE 5-15

A standard photograph. It looks nice, but let’s try to ““art it up.”” (Photo credit: Melody Smith)

Use the following steps to take this from a photo to an ink drawing;

1.

Create paths. It depends on the image you’re using, but use a combination of any of the
techniques explained in this chapter to define the shape of the subject with paths. If there
are nice solid colors that allow you to get clean selections, use the Fuzzy Select tool (U)
to build a selection and turn that into a path. For this example, I did a little bit of that,
but most of it was done by tracing the shapes I want with the Paths tool (B). For sections
where you know you’ll want thicker or thinner lines, create new paths in the Paths dialog.
It will make things easier on you down the road.

Add a layer and fill it with white (Layer > New Layer or Ctrl+Shift+N). Now that
you've created your paths, you need a drawing surface to work on. This is your base. It’s
mainly there to separate your line strokes from the original image. If you make your paths
visible in the Paths dialog by clicking the eye icon next to each path, the Paths dialog and
image window should look like Figure 5-16.

Add a new transparent layer (Layer > New Layer or Ctrl+Shift+N). This is where
you will be creating the strokes for your ink drawing.
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FIGURE 5-16

Paths created from your original image on a white surface
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Select one path and click the Stroke Path button (Edit > Stroke Path). When the
Stroke Path dialog appears, select Stroke with a Paint Tool. You have a bunch of choices
for which paint tool to use, but I'd recommend using either the Paintbrush or Ink tools.
The Paintbrush offers a bit more control over brush dynamics, but Ink tends to be more
procedural and look a bit cleaner. You may want to play with both to see what suits your
tastes best.

Enable Emulate Brush Dynamics. This is what’s going to give you that brushed ink
feeling.
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6. Activate the tool you've selected (Paintbrush or Ink) and adjust its settings in the
Toolbox. The Stroke Path dialog is non-blocking, so you can adjust the settings on these
tools without closing it. If you choose Paintbrush (P), it would be best to use one of the
hard Circle brushes. Also, expand the Brush Dynamics section and enable the Size check
box next to Velocity. If you're using the Ink tool (K), the main thing to adjust is the Size
slider. Figure 5-17 shows tool settings for Paintbrush or Ink that would work well for this
example.

FIGURE 5-17

Paintbrush and Ink settings that would work on this example image

7. Click the Stroke button in the Stroke Path dialog. This creates a nice ink-like line
along your path. Now, on this first go, the line may not behave the way you want. It may
be too thick in places or terminate strangely. In that case, just Undo (Ctrl+Z) and repeat
steps 4—6 until you get settings that you're comfortable with.

8. Repeat steps 4-6 for each path that you’ve created. Depending on how fine you need
lines to be, you may have to do a couple iterations to get the thickness that you want, but
each time you do it, it should be easier to guess the settings that you want.

9. Woohoo! Done! From this point, you can save your image and move on or you can go
down to your white layer and perhaps try to create a parchment texture to make your ink
drawing look like it’s had some wear and tear. You have all sorts of options to play with!
Have fun!
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Figure 5-18 shows the finished result of the image that started as Figure 5-15.

FIGURE 5-18

A digital ink drawing, quickly created from a photograph. How sweet is that?

Selecting with a Path

Because you can create a path out of a selection, as explained earlier in this chapter, it makes
sense that the reverse is also true. Because paths are often easier to edit, modify, and tweak than
some of the other selection tools, they’re an invaluable tool for making complex and irregular
selections. To create a selection out of a path choose Select » From Path (Shift+V) from the
menu in the image window or click the Path to Selection button in the Paths dockable dialog.
The advantage of using the Paths dialog is that you have greater control over how the selection is
made. Pressing Shift+V or using Select » From Path completely replaces your current selection
with a selection defined by the path. If you want the path to add or subtract from the current
selection, the way to go is to right-click in the Paths dialog and choose the option you need from
there.

Once you've created a selection out of your path, you can treat it like any other selection in
GIMP and adjust its feathering, fill it with a color or gradient, or use it as a mask for a color
operation or filter. If you did the logo-enlarging example near the beginning of this chapter, you
already used this feature. Like how I snuck that in there on you?

Note

When you’re exporting your projects from GIMP, be aware that most file formats don’t support saving paths
embedded in them. Path data is simply discarded in these formats, so if you want to keep your paths, it’s
highly recommended that you first save to GIMP’s native XCF format. After you’ve done that, export your
image into whatever other file format you need to deliver to other people.
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Summary

This chapter was all about paths: the way to take advantage of vector tools in a raster graphics
program like GIMP. You discovered that you can create paths by drawing them yourself or you
can generate them from any selection that you've made. The chapter covered the Paths dockable
dialog in detail and showed how you can let GIMP interoperate with vector drawing programs
by importing and exporting paths in the open SVG file format. You also found out how to use
paths effectively by painting along them or using them to build complex selections.

With any luck, you've got another valuable graphics weapon in your arsenal. Time to add

another one!
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